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This tutorial will instruct you on the use of the Keil Microsoft Windows based software devel opment tools
with the Intel 8x931Hx or 8x931Ax USB microcontroller. The 8x930xx based evaluation board is used
with the 8x931Hx Universal Serial Bus Adapter Board (USB931AXADBD) installed. The 8x 930xx
board used is the Rev B board with 4 USB ports. The Intel part number is USB93XEVALBD. The
earlier version had 3 USB ports and cannot be used with the 8x 931xx daughterboard.

The 8x 931xx daughter board supports both the 8x931Hx HUB device and the 8x 931Ax. It comeswith
the Hx deviceinstalled. The Intel Evaluation board can then be used as a hub device and will support one
upstream port and 4 downstream ports. If your peripheral will have other USB devices plugged into it, you
will need a Hub device such as the Intel 8x930Hx or 8x931Hx.

The 8x931Ax and 8x931Hx contain a MCS 8051 core and programs can be written with the Keil C51 C
Compiler tool set. The 8x930Ax and 8x930Hx contain a MCS°251 core and use the C251 Tool Set. A
companion Quick Start supporting the 8x930xx devices and is available from www.keil.com/~market.

For more information you may visit these Web sites:
http://developer.intel.com/design/usb http://www.usb.org
http://www.keil.com/usb http://ww.keil.com/~market
Keil is providing USB information of interest to developers. Thisincludes:
sample enumeration code.

instructions on how to compile code using the Keil compiler and burn it into an Eprom that will run
on the Intel USB board stand-alone.

C code sample programs to demonstrate other functions of dScope such as the Performance Analyzer
information on interfacing the Keil tool chain to a customer hardware board.
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1) Thisdocument is continually being updated. For the latest version check www.keil.com/appnotes or
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2) Every effort has been made to ensure that the information contained here actually works.
Please report any errors or omissions to the author at the addresses listed above.



INTRODUCTION

The Intel 8x931 USB microcontroller uses the MCS”8051 core. The Keil C51 compiler comes with an
additional header to accommodate the 8x931 USB peripheras. ThisfileisReg931.h andislocated in
the c:\c51\inc directory. If you are using the evaluation copy of the Keil software, the directory is
c:\cblevallinc. All facilities of the 931 microcontroller are accessible. Therest of this tutorial will
assume you are using the evaluation copy that came with your Intel package.

The Keil tool chain consists of the following executables located in the c:\c51eval\bin directory:

nVision uvw5le.exe
C Compiler  cbl.exe
Assembler abl.exe
Linker bL51.exe
dScope dsw51.exe
nVision IDE

nVision is a Windows based front end for the C Compiler and Assembler. It was developed in the USA
aswas the printed manual set. Compiler, Assembler and Linker options are set with simple mouse
clicks. nVision runs on Windows 3.1, 95 and NT. The Compiler, Assembler and Linker are DOS
executables. They can be accessed with your favorite batch filesif you prefer. This provides maximum
flexibility. This Integrated Development Environment (IDE) has been expressy designed with the user
inmind. A full function editor isincluded. All IDE functions are intuitive via pull down menus with
prompted selections. An extensive Help utility isincluded. External executables can be run from
within mVision. Thisincludes emulator software.

C51 C Compiler for the 8051, 8x931Hx and 8x931Ax [USB]

The C51 ANSI compiler along with the A51 assembler is designed specifically for the Intel MCS°8051
microcontroller family, including the 8x931 USB. The C51 is 100% compatible with existing 8051
programs. Extensions provide accessto al 8051 hardware components. Sample USB/931 codeis
available: www.keil.com/ush. C51 supports code banking. The compiler can berun in either DOS
maode or called from the Windows based front end mVision.

A51 Macro Assembler

This Macro Assembler isincluded with each Compiler package or is available separately. All utilities
needed to complete your project are included for all members of the 8051 family. This Assembler is
DOS based or can be run from nVision which isincluded with every Assembler and Compiler package.



BL51 Linker - Banked Linker

The BL51 Linker/Locator is used to join rel ocatable object modules and library files together. The
object files are created with the C51 compiler or the A51 Assembler using the Keil library files. The
linking process resultsin absolute object modules. The BL51 linker is DOS based and can be run
from DOS or through Windows using nVision. A MAP fileis produced giving details of the memory
structure. The object file may be specified to contain debugging information as required by simulators,
debuggers and emulators. The BL51 linker can overlay important internal RAM for variables to greatly
increase the speed of processing. The BL51 linker supports banking.

dScope Simulator

dScope is a software smulator. Y our code can be debugged either in software on your PC or in your
target hardware. When operated in conjunction with the Keil monitor installed in your target hardware,
dScope becomes tScope. Y ou have the ability to run/halt, set breakpoints, examine/change memory,
view the stack, view/set peripheral information, and apply virtual external signals. dScope hasa
Performance Analysis feature to ensure your code runs efficiently. dScope hasa
disassembler/assembler allowing you to make changes in your code without recompiling.

Evaluation Version of the Keil Tool Set

The evaluation version of the Keil tool set isrestricted to a 2K code size and the code must be located at
0x4000. Useful object codeis produced. Other than these restrictions, the tool set works exactly as the
full version does. Thisalowsyou to fully evaluate the features and power of Keil products. The full
version has no restrictions and is fully ANSI compliant.

ABOUT THIS TUTORIAL

Thistutoria consists of severa sessions illustrating the features of the Kell Tool Set. The C code
program shown in Figure 6 will be compiled and executed using various features of the Keil C51 Tool
Set. Thefocusison using Keil’s nVision integrated development environment. It explains how to
create and build a new project using a source code example provided in this tutorial.

The following steps below show you how to configure the tools, compile and link the code, and invoke
the debugger, dScope. Before you begin this tutorial, you need the Keil software development tools. To
get them do one of the following:

Locate the evauation version of the Kell software devel opment tools that was included with the
USB 8x931 peripheral development kit. This contains the example code for this tutorial.

Download the latest version of the software from the Keil web site (www.keil.com).
Purchase a complete package from Kell Software.

STARTING THE TUTORIAL

Installing the Keil Software

Ingtall the Keil Software development tools by completing the following steps:

1) Insert your installation diskette number 1 in the A: drive.

2) Inthe Program Manager sdlect File/Run...  (for Windows 95 select Start/Run...)
3) TypeA:\Setup at the Command Line Prompt.

4) PressOK.

5) Follow the on-screen prompts.

After you install the Keil development toolsto Windows 3.11, aKeil program group or icons appear on
your desktop. (the Windows 95 version is shown in Figure 1). Recall dScope isthe Keil Simulator and
nVision isthe Keill Windows based user interface (or IDE = Integrated Development Environment).



FIGURE 1

For Windows 95 you may have to ingtall the two icons manually asfollows. If the two icons are visible
in asmall window, drag them onto the desktop. If they are not visible, follow these instructions:

1) right mouse click while in the Desktop

2) sdlect New/Shortcut

3) the executable file you want to enter as the Command Lineis c:\c51leval\bin\uvw51e.exe
4) the suggested nameisnVision.

5) repeat this process for c:\c51eval\bin\dsw51.exe and name it dScope.

nVision creates the file uvw51e.ini in your c:\windows directory the first timeit is started. dScope
creates dsw51.ini. Settings are saved in these files for your next session. If you re-install the Keil
Tools, you may want to erase these files to obtain aclean install.

Starting the Software:

Double-click on the nVision icon to start the user interface. The compiler, assembler, linker and
dScope will be called from within mVision in thistutoria. After you invoke mVision, the window
shown in Figure 2 appears. From this window, you can create projects, edit files, configure the tool,
assemble, link, and invoke the debugger.

-‘!_(r'u\fisiun,'m evaluation !Elm

File Edit Project Bun  Options Tools  Window Help

== (= E@E) EEE FEE) (2] B

W¥ision evaluation for Windows | | | INUM | [

FIGURE 2

CREATING A NEW PROJECT

Open the Project menu and choose New Project. The window shown in Figure 3a appears.

Enter the name of the project you are creating. For thistutorial, enter the name usb.prj and press
OK. ush.prj will be entered under File name. Figure 3b will then open up.



Create New Project m

File name: Folders:

Im c:\chlevalibin

Cancel |
- oy -
51 1
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FIGURE 3a
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FIGURE 3b

Thiswindow is used to add various files to your project. Theseinclude ASCII files, C and assembly
source, and macros. Thelist is quite extensive and is found in the Trandator window if any files are
present in the project. Note thiswindow is blanked out at thistime. Thiswindow is accessible at any
time by selecting Project/Edit Project and you may easily edit your filelist. Note that any assembler
filesmust belast inthislist. If they are not, changes made to them may not be reflected in the final
object file.

When creating a new project in this manner no source files are yet available. Therefore, select save to

close thiswindow. Y our project usb.prj will be active. Click on Project and confirm usb.prj isvisible
at the bottom of this pull down menu.

CREATING A NEW SOURCE CODE FILE

Thistutorial uses asimple C program to illustrate features of the Keil Tool Set. It isshown in Figure 6.
The pathname for thisfile (example.c) is c:\c51eval\examples\tutorial\example.c. Type this programin
if you do not have thisdirectory: Thistutorial needs example.c in c:\c5leval\bin.

1) Dothisstepif you do not have the source. Open the File menu and choose New to go to the
nVision integrated editor. Use the editor to type in example.c in Figure 6. It should look like
Figure 5. When you have entered the file, do asave as to the c:\c51eval\bin directory asin Figure
4. The filename should be example.c for thistutorial. Thiswill keep things easy to follow.

2) If you have the source code as afile, choose Open and get example.c in the usua fashion. Y our
window should be similar to Figure 5. Note the color syntax allowing increased readability of your



source code. This sample program uses a number of simple C source lines to demongtrate the Kell
tool set. Thisprogram is used in the remainder of the tutorial.

3) Open the File menu and choose Save as. The window similar to Figure 4 appears. Save thisfilein
the indicated directory. Thistutorial usesthe directory: c:\c51eval\bin and the filename example.c.
Normally your project and source code would be in adirectory of your choosing.

4) At thispoint you have created a project called usb.prj and a C source file called example.c.
The next step is to build your project. Thisincludes compiling, assembling, linking and locating and
creating the hex file. The hex file would be programmed into an EPROM and is not used here.

Save As m

File name: Folders:
l:::\l::51 evalibin\example.c| c:\ch1evalibin

Cancel |
example.c - %c:\ -
chlewval
& bin Network. .. |

- w
Save file as type: Drives:
C Source (*.c) LI | = c: micron ;I
Figure 4
| "C pvision/51 evaluation - USB.PRJ [_[O]x]
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f EXAMPLE C

/x 8051/931 Example - Robert Boys, Copyright 1997 Keil Software Dallas, Texas x/ il
/% This is a simple program used to demonstrate the Keil debugger dScope x/

#include <reg931.h> /x declare 931 SFRs %/

#include <stdio.h> /= not -really- needed, but here it is anyhow ? x/
int var = 1; | /% declare an integer variable to be pointed to x/
int xptr; /= declare a pointer to point to an integer x/
void stepout(int q) /= declare a simple function called stepout x/
/x does not really do much but demonstrate the x/
int count; /= stepout, stepin and stepouer functions of dScope x/

int total = 0;

for (count = 1; count <= 10; count++)
q = qx2;
J
struct cord { /% declare the structure named cord =/
int x; /= with member variables x and y x/
int y;
) first, second; /% declare two structures with members x and y x/
void main(uoid) { /= start of the main program here x/
int b = 0; /% declare a few integer local variables x/ =
[ [ [ [ [NUM 8[ 35

/* 80517931 example.c - Robert Boys, Copyright 1997 Keil Software Dallas, Texas */
/* This is a simple program used to demonstrate the Keil debugger dScope */

#i ncl ude <reg931. h> /* declare 931 SFRs */
#i ncl ude <stdio. h> /* not -really- needed, but here it is anyhow ! */
int var = 1; /* declare an integer variable to be pointed to */
int *ptr; /* declare a pointer to point to an integer */
voi d stepout(int q) /* declare a sinple function called stepout */
{ /* does not really do nmuch but denonstrate the */

int count; /* stepout, stepin and stepover functions* of dScope/

int total = 0;

for (count = 1; count <= 10; count++)
q =g 2;



struct cord { /* declare the structure nanmed cord */

int x; /* with menber variables x and y */
int vy;
} first, second; /* declare two structures with nenbers x and y */
voi d main(void) { /* start of the mmin program here */
int b =0; /* declare a few integer local variables */

int count = 0
l ong bigcount =0

ptr = &var; /* declare ptr to point to the variable var */

*ptr = 3

first.x = 5; /* and initialize them */

first.y =5

second.x = 2

second.y = 2

whi | e(1) { /* start an endl ess |oop here */
P1 = 0;
first.x++; /* increment all the pointers */
second. y++; /* just for sonmething to do */
first.y++

second. x++

count ++; * increment this thing while we are here */
st epout (b); /* pay a visit to the function for a time */
bi gcount =bi gcount +2; /* add two to this long variable */
*ptr=*ptr*3; /* multiply var by three using its pointer */
P1=0xff;

}

Figure 6. Example Program



BUILDING THE PROJECT

1) Open the Project menu and choose Edit Project. The window shown in Figure 7 appears. Thisis
where you add various filesto your project. Note there are no filesin the project yet.

Source Files
Add | Save |
Remove | Cancel |
Move Up | Help |
Mowve Down |
Open | OpenAll |
Translator: ﬂ| Command: I
= Always Build = Inclodein Link/ Lk Object: I
I"Execute Bank pumber: l— errE‘rﬂlzlvel err%?l?azael l— e%nﬂrrrllti;\lf?al
FIGURE 7

2) Choose Add. Thewindow shown in Figure 8 appears. Thisiswhere you add the files to your
project.

Add File to Project 2] x]
File name: Folders: Add
E c:\chlevalibin

Close |
example.c - aac:\ -
chlewval
= bin Network... |

List files of type: Drives:
C Source (*.c) =] | = c: micron =
FIGURE 8

3) Sdectthefile: example.c and press Enter.

4) Choose Add then Close. Example.c will be listed in the Source Files window.
5) Make sure Include in Link/Lib is checked.

6) Choose Save.

CONFIGURING THE MAKE UTILITY, ASSEMBLER, AND LINKER

Keil Software has aMake utility that can compile and link C and/or assembly coded files. It also has
other configuration and default setting features. Before using the Make utility, configure the make
options. Make the changes as indicated, and leave all other options set to their default values.

In thistutorial, most of the default values are used. nVision alows you to set various options with
mouse clicks and these settings are saved in your project file. Examine some of the other tabsin each
window to see the flexibility of nVision. Do not make any changes other than those explained here.



1) Configure the Make utility.
Open the Options menu and choose Make.
Configure the options in the window as shown in Figure 9 and press OK.

Make Options (USB.PR.J) x|

l After Make I Misc I Extensions ]

After Compile
" Stop

Cancel |
& Run BL51 Banked Linker
" Run LIB51 Librarian Help |
™ Run OC51 Object Converter Default |
¥ Run OH51 Object Hex Converter

FIGURE 9
2) Configure the Compiler.

Open the Options menu and choose C51 Compiler. Click on the Object tab.

Note the DOS command line options are visible at the bottom of the window. Y ou will see what
actions are taken with your selections.

Configure the options in the window under Object as shown in Figure 10 and press OK.
It isimportant to turn on the Include debug information. Thiswill allow usto see the source codein
the debug window in the smulator and the monitor.

The assembler is not used in thistutorial. Assembler options are set in asimilar way asthe other
components of the tool chain.

Listing | Object | Optimization | Memory Model | Chip | Misc |

[~ Keep variables in order 0

¥ Include debug information

¥ Include extended debug information: Cancel

¥ Enable ANSI integer promotion rules Help

udd

[ Generate Registerbank Independent Code
Fnterrupt Yectors Default

¥ Include in object Interval: IB Offset: I“

Command Line Options String

DB OE —
v

FIGURE 10

3) Configure the Linker.
Open the Options menu and choose BL51 Code Banking Linker and click the Linking tab.

Ensure the default conditions as shown are properly set. Note thisiswhere the Banking, Real-time
Operating System and Variable Overlaying are controlled. See Figure 11.



BL51 Code Banking Linker (USB.PR.J) R

Listing || 1| sizeiLocation | Additional | Segments | Files |

Debug Information ———————— Target Options ————————————— 0K
¥ Include local symbols [” Code banking
Cancel
¥ Include public symbols [~ RTX51
Hel
¥ Include line numbers [~ BTX51 tiny it

Default
" lgnore default libraries

¥ Enable variable overlaying

Command Line Options String

RS(128) PL(68) PW(78)

|

FIGURE 11

COMPILING THE CODE AND CREATING AN EXECUTABLE FILE

With the tool configured, you are ready to run the compiler and linker using the Make utility.

1. Click onthe “Build All”” icon (it has three arrows pointing downwards) or open Options and select
Make.

If the program specified (example.c) has any errors, they will appear on the screen. Use the editor
to correct the error(s) in the source code and save the file. Y ou can double-click on the error of
interest and mVision will take you to the offending line in the source code. Y ou can edit thisline
and rebuild the project by repeating this section: beginning at step 1.

If there are no errors, the code is assembled and linked with the executable code ready to be
downloaded to the board. The Project Status window will state “Make Successful - HEX File
Created” if everything isworking properly. Continue to the next section.

The following files in the directory \bin are associated with this project:

example.c original source file - needed for debugging purposes.

example.bak abackup file produced by nVision.

examplelst alisting file of the source example.

example.obj arelocatable object file. Needs to be linked.

usb.prj the Project File. Note that the output code assumes the name of the project file.
ush.m51 map file.

usb.hex Intel Hex File Created by the Object to Hex Converter oh51.exe.

ush absol ute object file with debugging information (if so set in the compiler option)

Thisfileistheinput for the Kell smulator dScope and emulators. Thisfileis
created by the linker.



DOWNLOADING THE CODE TO THE 8X931 EVALUATION BOARD

Y ou must make sure the Intel board is configured and loaded according to the Adapter Board User’s
Guide. The procedure isto remove the existing 8x930Ax microcontroller U3, install anew PLD U8,
EPROM U1, and the Adapter board itself. The appropriate jumpers must be set according to the User’s
Guide.

Y ou are now ready to run the dScope debugger to download code to the eva uation board.

Supply regulated 5 voltsto P9 on the board. Please carefully apply the correct polarity. With the seria
cable not connected and the power applied to the board; the LEDs will indicate a self test and the even
numbers of P1 plus p1.7 will remain illuminated at the conclusion. Pressing the reset button will repeat
the self test. The green LED CR1 dways remainslit aslong as reset is not asserted. The four green
LEDs on the adapter board will aso blink in sequence. Connect the seria cable from a COM port on
your PC to the UART port on the Intel USB board.

With the serial cable hooked up; al the LEDs remain illuminated as the board is held in the reset
condition by the serial port. This assumes the seria port has not been initialized by dScopein a
previous session.

Click on the debugger icon on the nVision toolbar. Thisiconisa“d” seen through a magnifying glass
and isyellow and bluein colour. Thisisthe sameiconinstaled for dScope in your desktop area. If you
leave the mouse pointer on an icon for afew seconds, the word “debug” will appear. A window similar
to that shown in Figure 12 isdisplayed. Y ou may want to move and resize the windows. The window
marked “Module: <none>"" is the Debug window. The Command window will be needed to enter
commands.

@ dscope [_[o]x]
Eile View Setp Help
5] EEEEREEEEE [EE]
‘ Module: <none> MEIE ook H
Commands Gol GoTilCurs! StepQutl  Steplntol  StepOverl  Stopl e
| EHEH e EEN] [w]E]E] 2
C:0001H HOP L‘ q (o] x]
: i Regs
C:0002H HOP GoTilCurs
C:0003H HOP A=00 B-=00
C:0004H NOP Steplnto RO-00 R1-00
C:0005H NOP R2-00 R3-00
C:0006H HOP StepOver R4-=00 R5-00
C:0007H HOP —— R6-00 R7-00
C:0008H HOP epOu DPTR — 0000
C:0009H HOP T - O
C: 000DAH NOP Stop -
C:000BH NOP ERLTE ===ll——=
C:000CH HOP - Ge €:0000
C : 000DH NOP View Trace Cyc: 1}
C:000EH HOP RemEl Sec: 0.000000
C:000FH HOP ssemb’e...
C:0010H NOP L
C:0011H NOP
C:0012H HOP
C:0013H HOP
C:0014H HOP
C:0015H HOP
C:0016H HOP
C:0017H NOP
C:0018H NOP
C:0019H HOP
C:001AH HOP
C:001BH HOP
C:001CH HOP
C:001DH NOP
C:001EH NOP
C:001FH HOP
C:0020H HOP
C:0021H HOP
| lhll |stop -
I )
:/Command =1
dScope-251/Windows V1.3p
COPYRIGHT KEIL ELEKTRONIK GmbH 1996
=== Running in Demo Mode (2K)
>
!dos ASM ASSIGN BreakDisable BreakEnable BreakKill [TAB INS |
4
38 Start| $18 pvision/51 evaluatio.| (5] Explaring - Bin | &3 imbox - windaws Me...| B Micrasoh Ward - 931..| I USE Class -Wind... [ dscope Jdg A

FIGURE 12



INTERFACE SETUP

dScope is a software debugger and simulator. tScope is the debugger connected to a hardware system.
Programs are run on the target hardware rather than in the virtual microcontroller in your PC. The Keil
debugger tScope will communicate with the Intel RISM monitor contained in the EPROM on the USB
board. The COM port will be dependent on your configuration and the speed is 9600 baud.

The upper left hand corner of Figure 12 shows that dScope is active in this case. Thiswill change to
tScope if the appropriate dil (i.e. rism51.dll) is chosen. If you select 8051.dll, you will get dScope.
Y our ssimulation will not be run on the Intel USB board but in your PC as aready stated.

1) To establish communication with the evaluation board, choose the correct driver using the pulldown
list on the left portion of the debugger toolbar. In this example, rism51.dll is chosen.

2) rism51.dll: When the serial link is connected and the rism51.dll is selected for the first time, the
ledswill blink. The reset button in the tScope Toolbox window will also cause the lights to blink.
If you get this far, things are working properly. tScope should be displayed in the upper |eft hand
corner.

3) Thiswill happen only if communication is established. If the wrong COM port or speed is selected,
aseries of communication I/O timeouts will be indicated in the Command window. Should this
happen; follow the instructions under Communications Setup.

COMMUNICATIONS SETUP

Y ou need to follow these instructions if proper communication was not established. After a series of
attempts dScope will error out as indicated in the command window and a*“ Target System not found “
window will open. Y ou can now change the COM port and baud rate settings.

Select the appropriate COM port for your system. The speed must be 9600 for the external UART and
the Serial Break must not be enabled for this exercise. * Make sure your serial cable is plugged into the
UART!

After you set the COM port and baud rate to 9600, click on Try Again.

LOADING THE EXECUTABLE FILE TO THE DEBUGGER ENVIRONMENT

1) Open the File menu and choose Load Obiject file.

2) Inthe Window provided, select the file: usb. Thefileis downloaded to the board and the debugger.
Thisfile has no extension. Press OK.

3) To seethe Command window if not aready visible, select View/Command Window. To seethe
source code, select the Debug window in the same fashion if necessary. Module: example will
appear at the top of debug screen.

Y ou should see the source in the Debug window as in Figure 13 depending on how you have set your
windows. You can single step using the step-into icon. 'Y ou are now ready to use the dScope window
(really tScope) to step through code, set breakpoints, and issue the Go command to start program
execution. Y ou can examine special function registers, memory locations, and register values, etc.



&l tScope - c:\cbleval\bin\USB [_ O] %] EZl
File View Setup Peripherals Help = x|
ismstdl ] [@E[E=EEREERBEE] «=]E]
: Module: EXAMPLE = E | @ Tooibox  [E
Commands Gol GoTilCurs!  StepQuil Steplntol  StepOver!  Siopl e
v B e sl | —x~
17: for (count = 1; count (= 10: count++) Go
ig= 3 9 = q%2; i Regs =1 E3
19 GoTilCurs [ A=00 B-00
21: struct cord { = declare the structure named cord =/ Stepinto RO-00 R1=50
22: int x: = with member variables z and y =/ R2=00 R3=02
23: int y: StepOver R4-11 R5-01
24: } first, second: sx declare two Structures with members R6-04 R7-00
25: Stepout
DPIR - 0080
28: SP = 0000
27: void main(veid) { s= start of the main program here = Stop -
28: PSW: -—-RO-—-
|29: dmtb-0: /= declare a few integer local varia] 98 Esdpid
30: int count = 0 View Trace Cyc: 0
31: 1 bi t - 0: : 0.
I ong bigcoun T Sec: 0.000000
33: ptr = &var: ~% declare ptr to point to the variable war = I
34: =ptr = 3;
35: first.x - 5; #= and initialize them =/
36: first.y = 5:
37: second.x = 2;
38: second.y - 2:
39:
40: while(1) { /= start an endless loop hers =/
41 P1 - O:
42: First.xt+; /= increment all the pointers =/
43: second .y++: s= just for something to do =/
14: First.y++s
45: second.xt+:
46:
47: count++: = increment this thing while we are
48: stepout (b) ; s= pay a visit to the function for a time =~/
49: bigcount=bigcount+2; /= add two to this long wariable =/
50:
| lhil |stop -
4 » A
i Command =15
==x for maximum performance and features, install === B
==x Reil Monitor-51 into your target system. xx
= RESTRICTED VERSION WITH 2048 BYTE CODE SIZE LIMIT =
= CURRENTLY USED: 433 BYTE ( 21%) =
> _
!dos ASM ASSIGN BreakDisable BreakEnable [TAB [INS | f
KN Q|
48 Start| 8 1Vision/51 evaluatio. | (3] Exploring - Bin | By inbox-Windows Me.. | ¥ Microsai Ward -931. | I8 USB Class - windo.. [|@]scope - ccste... @B A 7a0aM

FIGURE 13

SAMPLE SESSIONS

High Level and Assembly Language Listing

1) Note the screen displays High Level language source code information. Thisis because the Debug

window is set to view HLL asindicated in the box just beneath “Commands’

2) Open thisbox and change it to Mixed and the screen will display both HLL and Assembly listings.

Also under commands/view/mixed.
3) Changeit back to HLL.

Single Stepping

1) dScope uses*“Step Into” to single step one instruction at atime. “Step Into” is aso used to enter a

function in the same fashion.
2) “Step Over” meansto skip over afunction that you are not interested in.
3) “Step Out” isused to exit afunction you are currently in. “Step Out” isvery useful if you find

yourself in afunction you are not interested in and need to return quickly to your intended function.

4) If dScope gets stuck - do areset using the RESET box on the Toolbox or click on the button next to
the Help “?’, reload the file and/or the DLL. You can dso try the 8051.dll to isolate any problems

from the evaluation board. Y ou can also use the hardware RESET button on the board.

5) Put abreakpoint on Line 49 and press Go. Click on Steplnto until you enter the function Stepout.
Note that you must click on StepInto 10 timesto exit the loop. Press Go to go back to Line 49.

6) Repeat the process using StepOver and you will not enter the function although it will be executed.

Thisis useful to skip function calls you are not interested in debugging.



7)

Note that the StepOut button is grayed out and not available in tScope. StepOut is available in the
simulator dScope and provides a quick escape from a function by executing the next return
instruction.

Breakpoints

1)

2)
3)

4)
5)
6)
7)
8)
9)

Reset using the RESET box on the Toolbox or click on the button with the red pointer at top of
screen. The lights on the board should change.

Click online41 P1 = 0 and a colored bar appears marking this position.

You could click on GoTilCurs! to reach this point or you could double-click and a breakpoint is set.
Set a breakpoint here with the double click. The [BRO] indicates the first breakpoint.

Click on GO and the program will run and stop at the breakpoint. - 6 LEDswill be on.
Click on Steplnto and the instruction will be executed extinguishing the LEDs.

Double click on the breakpoint to removeit.

Click onLine52 P1 = 0xff and press GoTilCurs!.

Click on Steplnto to execute the instruction and 6 of the LEDs will light up.

Click on RESET.

In Line Assembler

1)

2)
3)

4)

Open the Commands option and click on Inline Assembler or if Show Diaogbar is active, click on
the Assembl e button in the Debug window.

The Inline Assembler windows opens asin Figure 14.

Note that you could enter mnemonicsin the window titled enter MCS-51 instruction: Do not do
this at thistime. Just note the ability to make small changesin the program without recompiling the
program.

Click on Close.

Inline Assembler m

— disassembly:

c:0x4001  mov b(0x15).a

c:0x4003 mov 0x16.a

c:0x4005 mov count(Dx17).a

c:0x4007 mov 0x18.a

c:0x4009 mov Oxlc.a

c:0x400b  mov 0x1b.a

c:0x400d mov Oxla.a

c:0x400f mov bigcount{Dx19).a

c:0x4011  mov ria

c:0x4012  mov r2 #0x00 &~

current assemble address: C:0x4000
enter MCS-51 instruction: Show symbols... |
Assemble I
Close | Help |
Figure 14

Memory Window

1)

2)
3)

The Memory Window shows as the default the data space starting at D:0x0000. Thisisthe area
where data variables are kept in this example.

Open the View menu and select Memory Window. Position this window off the Debug window.

Note that as you step through the program that the contents of the memory changes as the variable
values are adjusted.



4) You can change the memory areawith the DISPLAY command in the Command window. Enter d
€:0x00 and the code area will be displayed.

5) Change back to the data area with d d:0x00

Addr 00 01 02 03 04 05 06 O7 08 09 ODA OB OC 0D OE OF 0123456?39A]A|
:0000: 09 10 OO0 OO OO OO OO OO OO OS5 OO OS5 OO O8 0D OB ...........
:0010: 00 1B 00 OO 10 OO OO OO O3 OO OO OO D4 OO OD OO ...........
:0020: 40 60 00D 0O C1 AD S0 00 20 OO0 A4 08 00 01 60 01 @ ...... ..
:0030: 08 08 08 08 34 00 04 81 93 41 80 81 00 OC 0D 80 ....4....A.
:0040: 03 80 41 01 18 90 S0 08 A2 04 00 00 DO OS5 21 00 ..A........
:0050: 02 20 08 01 80 00 31 20 00 20 26 20 O 82 18 00 . ....1 . &
:0060: 00 10 OO DO O9 OO 88 04 00 OD D2 OO0 02 OD 49 14 .......... ;J:J

Al

“  gogooog

Figure 15

Watch Window

1) The Watch Window displays memory contents as specified by their name. Structures can aso be
displayed.

2) Open the Setup menu and select Watchpoints. In the Expr.: window, enter the following symbols
one at atime followed by clicking on Define watch.
bigcount, first, second and var. Notethat if you also select Oxnn the vaues will be displayed in
decimal rather than hexadecimal notation. Try thisfor one or two of the variables.

3) These variableswill now be displayed in the Watchpoint window. Click on Close.
4) Click on StepOver and the variable values will changes as appropriate.

5) Note: when are using dScope (i.e. the software debugger) and if in the Update Memory Window
and Update Watch Window (in the Setup menu) are activated - the variable values will change as
the program isrunning. Thisfeature is not possible with tScope running on a hardware board.

6) Open the Peripherals menu and select Configuration. Activate enable serial break and click on
Apply then Close.

7) DoaRESET and start over as before. Press GO and then STOP and note that the values changein
both the Watch and Memory windows when the processor is stopped.

USB ENUMERATION

Introduction

USB devices are hot-pluggable. When adevice is connected to a PC, the periphera is detected and
certain communication occurs between it and the host. The appropriate drivers will be selected and the
peripheral will be installed on the host (the PC). Thisis the enumeration process and this can be
demonstrated with the Intel Evaluation board.

Host - Windows 95 B

A host isaso aHub. The fastest way to get a host isto get a PC motherboard with one or two USB
portsinstalled and running Windows 95 B. The B version of Windows 95 is sold at present only
(October 1997) to OEMs of PCs. It cannot be purchased separately.



It can be identified by checking the version of Windows by right clicking on "My Computer" and
selecting properties. The general tab will show the Windows version. If it lists the system as 4.00.950 B
then USB can be supported. A floppy disk should come with the computer labeled “USB Supplement
for Windows 95”. Thisiscaled“OSR 2.1". Thisdisk must be installed on your system and the USB
driver must be listed in the Device Manager under System Properties.

Demonstrating the Enumeration Process
1) Power up the 931 board without the seria cable connected. RISM need not be running.
2) Your USB equipped PC must have OSR 2.1 installed as mentioned above.

3) Connect the USB cable between the Intel board and the PC. The mouse arrow will turn into a
hourglass, then awindow indicating detection will appear.

4) If novalid USB device was detected If the hourglass returns to the mouse pointer; this means no
valid USB device was detected.

5) Thisindicates that Windows has detected the peripheral (the Intel board). It istrying to locate a
driver using the identifiers passed to it by the Intel board.

6) Windowswill not be ableto find a driver since none are loaded. The window in Figure 16 will
indicate that Windows could not find the appropriate drivers and is giving you the opportunity of
providing them.

Update Device Driver Wizard

This wizard will complete the installation of:

Unknown Device

by searching your local drives. netwark, and Internet locations
forthe most current driver.

[fyou hawe a disk ar CO-ROK that came with this device, insert
it N,

Itis recommended thatyou letWindows search for an updated
driver. To dothis, click Mext to continue.

< EHaEk Cancel

Figure 16

CONCLUSION

What else is there ?

Plenty...

Open the Command option in the Debug window and notice you can select High Level Language,
assembler or both (mixed) to be displayed and the trace. Note the trace only works for software
simulation - tScope is unable to determine the actual bus valuesin your hardware.

Open View and note the many windows you can open such as Watchpoints, Register, Performance
Analysis and Code Coverage.

Open Peripheras and you can see windows illustrating values of 1/O Ports, Timers and counters.

Open the Setup window and you can set many options such as the Performance Anayzer, Register
sets, breakpoints and Watchpoints.



OnlineHelp isaso available.

An Application Note giving instructions on how to replace the RISM Eprom in the Intel evauation
board with your own code produced with Keil software. Thisnoteisfor the 8x930Ax but can be
adapted for the 8x931. Get application Note 112 from www.keil.com

What is next ?

Plenty...

More sessions using C code will be prepared. More dScope features will be explored such asthe
Performance Analyzer, Watchpoints and Memory windows.

Check www.keil.com/~market for further details of more USB data.

For additiona information on Keil software development tools, visit the Keil web site at :
www.Keil.com. Check the Keil Marketing Group Web page at www.keil.com/~market.

Any problems or questions ? Call us. We are here to help you with your USB project.

Robert Boys
Dallas, Texas
October 15, 1997
800-248-8051
rboys@keil.com



Intel Support from Keil Software Inc. Dallas, Texas

Keil Software develops, manufactures, and distributes embedded software development tools for the 8051,
251, and USB microcontroller families. Toolsinclude C compilers, Assemblers, Real-time Executives,
Debuggers and Simulators, Integrated Environments, and Evaluation Boards. Keil has atraining facility
in Dallas for 8051 and USB products. Keil provides distribution, product development, and technical
support from its office in Dallas, Texas.

Keil’s web site [www.keil.com] provides the latest information about our development tools, demo
programs, software updates, application notes, example programs, and links to other sources of
information.

C51 C Compiler for the entire 8051 family and the Intel 8x931Hx/Ax

The C51 isafull ANSI C compiler with assembler. mVision isthe Windows User Interface that drives the
optimizing C51. The Compiler, Assembler and Linker options are point and click. nVision and the
manuals are written in the USA and extensive on-line help isincluded. Free technical support from
Dallasviaa 1-800 lineisincluded for one year.

C251 C Compiler for the 251 and the 8x930 [USB]

The C251 ANSI compiler with the A251 assembler are designed specifically for the Intel and Temic 251
microcontroller family, including the 8x930 USB. C251 is 100% compatible with existing 8051
programs. Extensions provide accessto all 251 hardware components. Sample USB/251 code is
available: www.keil.com/usb. C251 supports code banking, source and binary modes. Keil has afree
tutorial available for the new Intel 4 port USB evaluation module and the C251.

A51, A251: Macro Assemblers for all Keil supported microcontrollers

These three Macro Assemblers are included with their respective Compiler package or are available
separately. All utilities needed to complete your project are included for all members of the assembler’s
family. These Assemblers are DOS based or can be run from nVision which isincluded with every
Assembler and Compiler package.

nVision Integrated Development Environment - Windows based User Interface.

nVision isaUSA developed Windows-based front end for all Keil Compilers and Assemblers. It includes
an editor, project manager, and make facility. Compiler, assembler, and linker options are set by pointing
and clicking on prompted selections. Program Manager conveniently accesses your files, and 3 party
executables and also calls the Keil Simulator dScope easing the transition from utility to utility. Works
with Windows 3.11, 95 and NT.

dScope-Debugger and Simulator for the 8051, 251 and 930. Windows or DOS based.

dScope is a source-level debugger that lets you debug programs created by Keil compilers. dScope
simulates your program either in stand-alone mode or in your target using the monitor. External
hardware, signals, and interrupts can be simulated. Viewable windows include View Program from 1/O,
Trace, Stack, Watch and CPU registers plus more.

TR51/FR51/FR251 Full-Function RTOS for the entire 8051, 251, 8x930 and 8x931 families

The RTX51 and RTX251 are a multitasking Real-time Operating Systems for the entire 8051, 251, 8x931
and 8x930 families. This powerful tool lets you manage multiple tasks on asingle CPU. The RTX51 Full
includes CAN libraries. The RTX51 Tiny isasubset of the RTX51 Full. Functions include interrupt and
memory management, clock, and semaphores. Royalty-free.

CAN Library

The RTX51 Full RTOS supports CAN controllers with the included libraries. The CAN libraries are sold
with the RTOS. The CAN interface is becoming popular for automotive and industrial markets. 11 and
29 bit identifiers are supported. Keil 8051 C compilers interface with the RTOS and CAN libraries. Keil
supports al 8051 CAN microcontrollers including the Intel 526 and 527.

Upgrades



Free upgrades for Keil compilers are available from the Web to registered users. Special upgrade prices
are available for selected Franklin and Archimedes compilers. Call Keil for details on how to save money

using this special program.

Keil Software phone (800) 348-8051

16990 Dallas Parkway, Suite 120 phone (972) 735-8052

Dallas, Texas 75248-1903 fax (972) 735-8055
Email sales@keil.com

Web www.keil.com
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